Departamento de Campus de Arrosadia

u p n a Autométicay Computacion Arrosadiko Campusa

. 31006 Pamplona - Irufiea
Automati ka eta} Tfno. 948 169113, Fax. 948 168924
Konputazio Saila Email: ayc@unavarra.es

Practica 7 — Protocolos de acceso al medio: ALOHA y CSMA
“Sesion 2"
1- Objetivos

En esta segunda sesién analizaremos €l protocolo CSMA y lo compararemos con ALOHA.
Ademas plantearemos un escenario donde evaluar las prestaciones del protocolo de acceso a medio
de Ethernet en un medio compartido.

2- Avisos generales

Si quieren conservar cualquier fichero entre sesiones guardenio en una memoria USB, dado que
no se asegura que los ficheros creados o modificados durante una sesion de précticas se mantengan
paralasiguiente.

En lasesion 3, necesitara hacer uso de |0s proyectos creados en esta segunda sesion.
3- ALOHA vs CSMA

OPNET dispone de un tutorial idéneo para € analisis de protocolos de acceso al medio, es €
denominado CSMA/CD. Se puede encontrar en el menu Help de la ventana principal de OPNET, . Al
seleccionar este menu, observaremos que aparecen entre otras opciones “ Product Documentation” y
“Tutorials’. En la primera de ellas podremos encontrar informacion relativa a simulador, sobre como
utilizarlo, qué posibilidades ofrece, descriptores de los modelos que ya tiene predefinidos, etc... Se
trata de un pequefio manual a que acudir en momentos de duda. En la segunda, dispondremos de una
serie de tutoriadles que permiten observar y llevar a cabo la puesta en practica de algunos de los
aspectos explicados tedricamente en €l apartado anterior.

Puede serle de utilidad consultar la“lecturarecomendada’ en lapractica 1.

Como documentacion adicional, dispone en laweb de la asignatura, de un listado de funciones de
OPNET necesarias para la comprension de determinadas secciones del tutorial. Abra e documento
desde la ventana de Opnet Help > Tutorials y comience € tutorial CSMA/CD.

Nota: Realice € tutorial desde la pagina 53-70.
Errata tutorial CSMA/CD(OPNET 10.5): Pagina 55, punto 7 => j Correcto!

Laerrataradica enlafigura dela pagina 54 en relacion a este punto 7.

Analice en detale cada uno de los pasos indicados por €l tutorial con objeto de entender el por
qué de cada uno de ellos. Deberia ser capaz de responder alas siguientes preguntas:

1. ¢Quédiferencias existen entre lo que se denomina streamwire y statistics wire en € editor de
nodo?

2. ¢Entre qué estados se aplicalacondicion PKT_ARVL & & FREE? ¢Qué significado tiene?

3. ¢Qué meoraha necesitado afiadir a su modelo de transmisor para que soporte CSMA?
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4. En e modelo de proceso del transmisor CSMA, ¢Qué procedimiento se emplea para verificar
s el cana estd libre? ¢En qué estado se encontrara dicho modelo s € cana resulta estar
ocupado?

Checkpoint 7.4: Explica € disefio del transmisor de CSMA, tanto a nivel de nodo como de
proceso, relacionandolo con el comportamiento que ha de tener por utilizar CSMA como protocolo
de acceso a medio.

Checkpoint 7.5: Represente gréficamente e throughput del canal en funcién del tréfico,
considerando todas las simulaciones. ¢Cudl es la eficiencia de CSMA? ¢Coincide con la vista en
teoria? Indique cud es el valor maximo del throughput. Razone su representacion grafica. Realice
una comparativa grafica CSMA vs. ALOHA.

5. ¢Cud de los dos protocolos presenta un mejor resultado en cuanto a eficiencia se refiere?
¢Cabia esperar que asi fuera? ¢Por qué?

4- Evaluacion de prestaciones del protocolo de acceso al medio de
Ethernet

Ethernet es un estandar de redes de computadoras de &realocal con acceso a medio por contienda
CSMA/CD o Carrier Sense Multiple Access with Collision Detection. CSMA es una técnica de
acceso amedio compartido que permite alos equipos escuchar € canal antes de transmitir paraver si
otro equipo lo esta haciendo. Existen distintas variantes de este mecanismo, uno de ellos es
CSMA/CD.

CSMA/CD permite detectar no s6lo si un equipo esta transmitiendo, sino si ha habido colisién, de
manera que en base a esta informacién los equipos puedan variar su comportamiento. Existen tres
variantes:

e CSMA no-persistente: en caso de estar ocupado e canal, se espera un tiempo aleatorio y se
vuelve a escuchar, paratransmitir inmediatamente si se encuentralibre.

e CSMA p-persistente: s e canal estd ocupado se mantiene a la espera de que se libere para
transmitir. En caso de estar libre transmite con una probabilidad p y con (1-p) permanece ala
espera.

e CSMA l-persistente: s e canal se encuentra ocupado se mantiene a la escucha del canal
hasta detectarlo libre y transmitir. Esto hace que puedan ocurrir colisiones siempre que haya
dos estaciones escuchando.

¢Queé protocolo de acceso a medio emplea Ethernet?

4.1 Crear el proyecto

Para crear un proyecto nuevo paralared de Ethernet:
1. Ejecutar OPNET Modeler 10.5 -- Educational Version => Seleccionar New del menu File.
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Seleccionar Project => Clic OK => Nombre del proyecto <arssXY> Ethernet, y
escenario Coax => Clic OK.

En & Sartup Wizard: En la ventana de didlogo Initial Topology, asegurarse de Create
Empty Scenario esta seleccionado => Clic Next => Elegir Office de la lista Network Scale
=> Clic Next => Asignar 200 a X Span y mantener Y Span con 100 => Clic Next dos veces
=>ClicOK.

Cerrar laventana de dialogo Object Palette .

4.2 Crear la Red

Para crear |a Red Ethernet coaxial:

1.
2.

3.

Seleccionar Topology => Rapid Configuration. Elegir Busy Clic OK.

Clic en e boton Select Models en la ventana de didlogo Rapid Configuration. Desde el menu
desplegable Model List elegir ethcoax y Clic OK.

En laventana de didlogo Rapid Configuration, fijar los siguientes 8 valoresy pulsar OK.

] Rapid Configuration: Bus

— Modelz
..
Mode model: Iethu:u:ua:-:_statinn LI Mummber: |3|:|
Link. model; IEth_DDEIH hd Tap model I eth_tap ;L
— Placement
o r Head of Buz — — Size !
+ Harizantal Wertical o
_ - g IEEI g I'I?EI
v Top of bus [T Left of bus & Bl
[¥ Battom of bus [T Eight of bus i IE':I Tap: |2E' |
Select Models... | ] I Cancel |

Para configurar el bus coaxial, Clic-derecho en e enlace horizontal => Seleccionar Advanced
Edit Attributes del mend:

a. Clicen e vaor (value) del atributo model => Seleccionar Edit del menu desplegable =>
Elegir el modelo eth_coax_adv.

b. Asignar € valor 0,05 al atributo delay (retardo de propagacion en seg/m).

c. Asignar 5 al atributo thickness.

d. ClicOK.
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+] {bus_0) Attributes

| Attribute

[ harmne
I model

|—I:|er

I coll madel
I color

I condition
|— cost

|— data rate
|— delay

|— et model
F emor model

I line style

|— syrnbol

|— thickness
|— bxdel model
L uzer id

PEOEIIIIIIIRNERARARERRRN

|— channel count
I closure model

I finanzial cost

I packet formats
|— propdel model

I creation sournce
I creation timestamp
|— creation data

Redefine F'athl Extended Attrs. |

[~ Apply changes to zelected objects

Find Mext |

eth coax_ady

R apid Configuration

18:26:25 abr 27 2003

0.0

1
dbu_closure
dbu_call
RGEOCOO
enabled

0.0
10.000.000
0.05
dbu_ecc
dbu_errar
0.00

zold
ethernet
dbu_propdel
niore

4]

dby_twdel

1]

= |

=
J

v Advanced

Cancel |

5. Yase hacreado lared. Compare con lafigurasiguiente. En caso de que se vealared muy
pequefia o grande, se debe gjustar el zoom para seguir trabajando.

noé noé

B EE

BEaEnEeEEsE

: 22 nou:l‘ nocl‘ : 28

o oo e e e e AT SR e o - o e U P S s R e I S 4 e £ e s L s e £ L e U e | s e £ £ 8
b b ¥ b k. ¥ ¥ b ¥ ¥ ¥ ¥ ¥
= = = = = = = = = =) = = =

‘hode_1 hode_3 node_ & hode_7 niode: 9 node_11 rade 15 mode_17 | rade 19 mode_ 21 nade 23 node_ 25 node 27 mode_29

6. Salvar e proyecto.
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4.3 Configurar los nodos de lared

Configuracion del trafico generado por los nodos:

1.

2.
3.

Clic-derecho en cualquiera de los 30 nodos => Select Similar Nodes. Ahora todos los nodos
delared estén seleccionados.
Clic-derecho en cualquierade los 30 nodos => Edit Attributes.
Marcar lacaaApply Changesto Selected Objects para que se apliquen los cambios a todos
los nodos.
Expandir e arbol Traffic Generation Parameters:
a. Cambiar € valor ON State Time a exponential(100) => Cambiar el valor de OFF
State Time aexponential (0). (Nota: Los paguetes solo se generan en el estado ON.)
Expandir el arbol Packet Generation Arguments:
a. Cambiar e vaor del atributo Packet Size a constant(1024).
b. Clic-derecho en € atributo Interarrival Timey elegir Promote Attribute to Higher
Level. Esto nos permite asignar multiples valores a atributo Interarrival Timey por
lo tanto probar las prestaciones de lared bajo diferentes model os de carga

| (node_10) Attributes

T_l,lpe;l station

|.-5'-.ttril:|ute ;I
) -name ode 10 '
& | model ethcoas_station
@'} [=I Traffic Generation Parameters [...]
@ |— Start Time [zeconds] constant [9.0]
@ |—EIN State Time [zeconds] exponential (100] -—
@ |—EIFF State Time [zecondsz] exponential [0] o
@ [=] Packet Generation Arguments [...]
) F Interariival Time (seconds) promoted -+
el |- Packet Size [bytes) constant [1024) -+
@ L Segmentation Size [bytez] Mo Segmentation
@'} L Stop Time [zeconds] Mewer
@ L Traffic Generation Parameters [0].Packet... promated

=l

[+ Apply changes to selected ohjects —— [T Advanced
| Find Mext | ok | cance |
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6. Clic OK para volver al Editor de Proyectos. S aparece una ventana avisandole que esa
configuracion se afadira a cada nodo, pulse en Yes.
7. Salvar € proyecto.

4.4 Configurar la simulacion

Para examinar €l desempefio de lared bajo cargas diferentes, necesita correr la simulacion varias
veces cambiando la carga en la red. Hay una manera fécil de hacer eso. Recuerde que utilizamos €l
atributo Interarrival Time (tiempo entre llegadas) para la generacion de paguetes que los nodos
inyectan a la red. Dicho atributo se marc6 como Promote Attribute to Higher Level. Aqui
asignaremos valores diferentes a ese atributo:

1. Clicen € botén Configure/Run Simulation:
2. Asegurese de que esta seleccionada larama Common => Asignar 15 segundos a Dur ation.

] Configure/Run DES: arss-Coax

. . : [~ Save vector and environment files for each mnin set
Simulation Set Infa | Murmnber of runs in set: 1 )
[ Pause betwest each i it set
— Cammon

- Glabal Attributes Duration: |15 |secondis) <

—  Object Attributes Szl I'lza— Multiple Seed Yalues... |

—  Erwironment Files
E— Outputs Yalues per statistic: I'IEIEI

— FRepoits

—  Animation Lpdate interval: I'IUEIDEIEI events

— Statistics Collection . . " "

L Logaing Simulation K.emel: IEased on 'kemel_type' preference j [Preference set to "'development')
+ Execution
Runtirne Dizplays

I~ Show OPMET Conzole during simulation
I~ Fause for user input before closing OFMNET Consale when simulation ends
Comments: ;I
=
=
Run Cancel | Apply I Help |

3. ClicenlaramaObject Attributesde I nputs.

4. Clic en @ botén Add. La ventana de didlogo Add Attribute debe aparecer llena con los
atributos generados para todos |os nodos de lared (si no vieralos atributos en lalista, cierre el
proyecto y reabralo). Necesita afiadir € atributo I nterarrival Time paratodos los nodos. Para
hacerlo:

a. Clic en @ primer atributo de la lista (Office Network.node 0.Traffic Generation
....) => Clic en € boton Wildcard => Clic en node 0 y seleccione asterisco (*) del
menu desplegable => Clic OK.

b. Vera un nuevo atributo conteniendo e asterisco (el segundo de la lista). Para
configurarlo necesita hacer Clic en lacelda bajo la columna Add?

c. Laventanade didogo Add Attribute debe parecerse alasiguiente. Clic OK.
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] Add Attribute: scenario

Add? | Urresolyed Attributes ;l
Office Metwark. node_0. Traffic Generation Parameters .
flice Metwork, . Traffic Generation Parameters [0].Pa...
Office Metwark. node_1. Traffic Generation Parameters .
Office Metwork. node_10.Traffic Generation Parameter. ..

Office Metwork. node_171.Traffic Generation Parameter. ..
Qffice Hetwork. node_12. Traffic Generation Parameter. ..
Office Metwark. node_13. Traffic Generation Parameter. ..
Office Metwark. node_14. Traffic Generation Parameter. .
Office Metwark. node_15.Traffic Generation Parameter. .
Office Metwark. node_18. Traffic Generation Parameter. .
Office Metwark. node_17 . Traffic Generation Parameter. .
Office Metwork. node_18.Traffic Generation Parameter. ..
Office Metwork. node_19.Traffic Generation Parameter. .. ;I

Expand... | 0k I Cancel |

5. Ahoradebe ver Office Network.*. Traffic Generation Parameter ... en lalista de atributos
de objetos de simulacion. Clic en € atributo para seleccionarlo => Clic en € boton Set
Multiple Values en la ventana de diélogo.

6. Afadir los siguientes 9 valores. (Nota: Para afadir € primer valor, doble-Clic en la primera
celda de la columna Value => Teclee “exponential (2)” en la ventana de texto y pulse Enter.
Repetir esto para los 8 vaores restantes: 1, 0.5, 0.25, 0.1, 0.05, 0.035, 0.03, 0.02. Se
recomienda empleen notacion cientifica ya que € ssimulador no interpreta bien valores del
tipo O, (cero coma) 6 0. (cero punto))

ﬂ Attribute: Office Network.™. Traffic Generation Parame... E|

Enter one ar more walues:
Yalue | Limit| Step ;I

expanential [£]
exponential [1]

exponential [5E-1]
exponential [25E-2]
expanential [(1E-1]
expanential [5E-2]
exponential [35E-3]
exponential [3E-2]
expanential [2E-2]

=
Delete | ok I Cancel | Dretailz |

7. Clic OK. Ahora observe en la esgquina superior derecha de la ventana de didlogo y asegurese
gue Number of runs es 9.
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B[(=1[ES

[~ Save vector and environment files for each mn in set

Simulation Set Info | Mumber of runs in set: 9 -—— .
[~ Pause between each un in set

E Comman ;I — Object Attributes
— Inputs _

—  Global Attributes Attribute |\-"alue ;|
— (I butes

0 NIRRT O =<ponential (2], exponenhial (1], esponenhial [5E-1], exponential [25E -2), exponential [1E-1]), &

— Erwironment Files
[E Outputs

— Reportsz

— Animation

— Statistics Collection
'— Logging

+ Execution

Fiuntime Dizplays

4 | o

¥ Usze default values for unresalved athibutes

Add... | Delete Expand... | SetMuItipIeVaIue3...| Update I Detailz |

[~

Fiun Cancel | Apply I Help |

8. Para cada una de las 9 gecuciones de la simulacion, necesitamos que e simulador salve un
valor “scalar” que representa la carga media “average” en la red y otro valor escalar que
representa la utilizacion media (throughput) de la red. Para salvar esos escalares necesitamos
configurar € simulador e indicarle dénde debe salvarlos. Clic en larama Statistics Collection

de Outputs.
9. Asigne<arssXY>_Ethernet_Coax al campo de texto Scalar file.
] ConfigurefRun DES: arss-Coax EIE'E'
. . [~ Sawve wector and environmert files for each rwn in set
Simulation Set Info | Mumber of mins in set: 3 ;
[~ Pauze between each run in set
Comman ﬂ — Statistice Collection
g |nputs )
| Global Athibutes Probe file: arss-Coax
I Dbiept .t'-‘«ttribuh_as [~ Start collecting statistics at ime [sec): ID
“— Enwironment Files
= Outputs [~ Stop collecting statistics at time [sec): |1EIDEI
— Feparts
—  Arimation Wectar file: arss-Coax
— BEE
L Logging Scalar filer Iarss_Ethemet_Euaﬂ j
+—  Execution [~ Clear scalar file befare running simulation set
Runtime Dizplays
Run Cancel I Apply Help

10. Clicen Apply, y salve & proyecto (para €llo necesitara pulsar Cancel).
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4.5 Seleccionar estadisticas

Para seleccionar las estadisticas arecoger de la simulacion:

1. Clic-derecho en cualquier punto del area de trabao (pero no en algin nodo o enlaces) y
seleccione Choose Individual Statistics del menid desplegable => Expanda € arbol Global

Satistics.

a. Expanda € arbol Traffic Sink => Clic en e check box proximo a Traffic Received
(packets/sec) (asegurese de seleccionar las estadisticas con unidades en packets/sec),
b. Expanda € arbol Traffic Source => Clic en € check box préximo a Traffic Sent

(packets/sec). Clic OK.

Campus de Arrosadia

Arrosadiko Campusa

31006 Pamplona - Irufiea

Tfno. 948 169113, Fax. 948 168924
Email: ayc@unavarra.es

2. Ahorapararecoger lamedia de las estadisticas anteriores como un valor escalar:
a. Seleccione Choose Statistics (Advanced) del ment Smulation.

b. Traffic Sent y Traffic Received deben aparecer bajo Global Statistic Probes.
c. Clic-derecho en Traffic Received => Edit Attributes. Poner € atributo scalar data a
enabled => Poner € atributo scalar type atime average => Comparar con lafiguray

ClicOK.

d. Repetir los pasos anteriores con Traffic Sent .

- o

| (pb0) Attributes

Seleccione save del menu File en laventana Probe Model y ciérrela
Havuelto al editor de proyectos Project Editor. Asegurese de salvar su proyecto.

|
-

| Attribute | Yalue
(® name lpbﬂ
@ | draw style linear
@ Faoup Traffic: Sink
@ |— shatiztic Traffic Receved [packets/sec)
& | odinate label
| vector data enabled
) |— wechar start 0.0
) |— wechar stop irfirity
& Fscalar data enahled -
@ |— gcalar type time average -
B | scalar start 0.0
| scalar stop ifiriity
& | capture mode bucket/default total/sum_time
| thieshold comparison dizabled
) |—threshnld walue 0.0
) |—threshnld percent 30
i Litag niare

[

[T Apply changes to selected objects
[ Find Mext | 04 Cancel |
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4.6 Ejecutar la simulacion

Para g ecutar la simulacién:

1. Clic en @ botén Configure/Run Simulation |Cn:|nFigure,l'Run Discrete Event Simulakion I{DES]I| =
Asegurese de que Duration marca 15 second(s) (no horas) => Clic Run. Dependiendo de la
potencia del ordenador esto puede tardar algunos minutos. En los ordenadores del 1aboratorio
apenas llevara unos segundos.

2. Ahora & ordenador esta realizando las 9 gecuciones, una por cada tasa de generacion de
tréfico. Es normal gque las gecuciones tarden cada vez més porque la primera es la de menor
cargay se vaincrementando hastallegar ala Gltima que simula un mayor tréfico.

3. Despuésde que e simulador termine las nueve gjecuciones, clic Close.

4. Salve su proyecto.

Si vuelve a repetir la simulacion, OPNET afadira los nuevos resultados a los resultados ya
existentes en € fichero escalar. Para evitar esta circunstancia borre el fichero escalar antes de
arrancar la nueva simulacion.

e Ir al ment File => Seleccione Model Files => Delete Model Files => Seleccione ( .0s):
Output Scalars => Selecione el fichero escalar a borrar;
(<arssXY>_ Ethernet_Coax_Scalar) => Confirmar borrado con OK =>Clic Close.

4.7 Ver los resultados

Paraver y andlizar |os resultados:

1. Seleccione DES, Results, View Results (Advanced):. Ahora se abre la herramienta de
Analysis Configuration.

2. Recuerde que los resultados de la simulacion los salvamos en un fichero escalar. Para cargar
ese fichero seleccione L oad Output Scalar File del mena File => Seleccione
<arssXY>_Ethernet-Coax del menu desplegable.

3. Seleccione Create Scalar Panel del menu Panels => Asignar Traffic Source. Traffic Sent
(packets/sec).average aHorizontal => Asignar Traffic Sink.Traffic Recelved
(packets/sec).average a Vertical => Clic OK.

i] Select Scalar Panel Data @
Harizamtal: Traffic Source. Traffic Sent [ j
Wertical: Traffic Sink. Traffic Receivec j

] LCancel |

4. El gréfico resultante debe ser similar a de lafigura siguiente:
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i] modeler g@g|

Traffic Sink. Traffic Received [packets/zec) average

150

100

Fia]

50

25

I | | |
o 400 200 1.200

Traffic: Source. Traffic Sent [packets/sec] average

Checkpoint 7.6: Explicar e grafico obtenido en la simulacion que muestra la relacion entre
paquetes recibidos (throughput) y enviados (carga). ¢Por qué e throughput es bajo cuando la carga es
muy baja o muy alta?

Nota: En caso de no terminar & checkpoint 7.6, podra continuarlo en la sesion 3.
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